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ORC 3327.01
TRANSPORTATION OF PUPILS

Shall deliver students enrolled in preschool through
twelfth grades to their respective public and nonpublic
schools:

" not earlier than thirty minutes prior to the beginning
of school

" be available to pick them up not later than thirty
minutes after the close of their respective schools each
day.



CONSIDER THEM AS BOOK ENDS

1-1

Funding

by
Students
or miles




FILING DEADLINES

*T-1: November 1

 Amended T-1:
Jan. 31

Calendar




TRANSPORTATION FORMULA: FY25

FY25 count week Oct. 7-11
What does the State fund?

v Yellow School Bus (type | & II)

v Public Utility (i.e. Metro/COTA/TARTA) (type lII)
v Vehicles other than a school bus (type V & VI)
v Supplemental Transportation (type |A)

v Special Education Transportation (not part of
“foundation formula”) (type VI)

W



COMPLIANT TYPES OF TRANSPORTATION

Board-owned,
leased, and

operated school
buses




COMPLIANT TYPES OF TRANSPORTATION

Students
transported by
school bus

service
contracted from
another school.




COMPLIANT TYPES OF TRANSPORTATION

Contractor-
owned, leased,
and operated

school buses
assigned
exclusively to a
given district.




COMPLIANT TYPES OF TRANSPORTATION

Public Utility




ORC 3327.017
MASS TRANSIT TO TRANSPORT COMMUNITY AND NONPUBLIC SCHOOL STUDENTS

No city, local, or exempted village school district shall provide or
arrange for transportation for any eligible student enrolled in any of
grades kindergarten through eight in a community school
established under Chapter 3314. of the Revised Code or chartered
nonpublic school to and from school using vehicles operated by a
mass transit system, unless the district enters into an agreement with
that school authorizing such transportation. An agreement under
division (B) of this section shall not be effective unless both the
school district and community or chartered nonpublic school

gAPprove It.



ORC 3327.017
MASS TRANSIT TO TRANSPORT COMMUNITY AND NONPUBLIC SCHOOL STUDENTS

A school district that elects to provide or arrange for
transportation for any eligible student enrolled in any of grades
nine through twelve in a community or chartered nonpublic
school to and from school using vehicles operated by a mass
transit system shall ensure that the student is assigned to a route
that does not require the student to make more than one transfer.



OTHER COMPLIANT METHODS

Type IV

Type V

Type VI

Type VI

Payment in
Lieu of




ORC 3327.02

RESOLUTION DECLARING IMPRACTICALITY OF TRANSPORTATION-OFFER
OF PAYMENT IN LIEU OF TRANSPORTATION

The time and distance required to provide the transportation;

The number of pupils to be transported,;

The cost of providing transportation in terms of equipment, maintenance,
personnel, and administration;

(4) Whether similar or equivalent service is provided to other pupils eligible
for transportation;

(5) Whether and to what extent the additional service unavoidably disrupts
current transportation schedules;

(6) Whether other reimbursable types of transportation are available.
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ORC 3327.02

RESOLUTION DECLARING IMPRACTICALITY OF TRANSPORTATION-OFFER OF
PAYMENT IN LIEU OF TRANSPORTATION

Such determination shall be made not later than thirty calendar
days prior to the district's or school's first day of instruction, or in
the case of a student who enrolls within thirty calendar days prior
to the first day of instruction or on or after the first day of
instruction, not later than fourteen calendar days after the
student's enrollment.

W



ORC 3327.02

RESOLUTION DECLARING IMPRACTICALITY OF TRANSPORTATION-OFFER OF
PAYMENT IN LIEU OF TRANSPORTATION

The board or governing authority shall issue a letter to the
pupil's parent, guardian, or other person in charge of the pupil,
the nonpublic or community school in which the pupil is
enrolled, and to the state board with a detailed description of
the reasons for which such determination was made. The
submission to the department shall be submitted to:
PILOtransportation@education.ohio.gov

1

(2


mailto:PILOtransportation@education.ohio.gov

EEEE——
A district that wishes to provide payment in lieu of transportation to a student must follow the steps below. For a full explanation
of each step, see page 2. If a parent/guardian rejects payment in lieu of transportation and requests mediation, until the
Department makes a final decision the district must provide transportation to the student.

District Passes
Resolution

Offers Parent
Payment In Lieu

Parent Accepts Parent DOES NOT
Payment In Lieu Accept

Mediation Succeeds Mediation FAILS

No Hearing
Requested

Hearing Requested/
Hearing Officer

Conducts Hearing

N/

Office of Legal Counsel
Sends Hearing Officer

Department Makes —
Decision

Report/Recommendation

For full explanation of
each step, see page 2.

> Complete

* Ohio Revised Code 3327.01
2 A school district may declare a student impractical only if it is statutorily required to transport that student.

*0Ohio Revised Code 3327.02 ———1 Department of
W Education &
1| Payment In Lieu Process | May 2024 —r Workforce

W



OTHER COMPLIANT METHODS

Type IV

Type V

Type VI

_
!
e
_
!
_
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Type VII

Board-owned
vehicles other
than school buses

O or fewer
passengers




OTHER COMPLIANT METHODS

Type IV
o= Privately-owned

vehicles other

Type V than school buses

Includes contracts

with parents
(special education)

Type VI

_
]
_
]
L ]
_
]

Type VI




OTHER COMPLIANT METHODS

Type IV

Type V

Type VI

Type VI

Community
school students
who are
transported by the
community school




FUNDABLE STUDENTS

Regular Education
v'PK-12 Students (state law requires K-8)

v'All residential eligible Typical Students from
assigned school

v'Public school (PS)
v'"Non-public School (NP)
v'Community School (CS)
Special Education
(Separate funding process)



REGULAR TRANSPORTATION

Greater of statewide cost per
rider or cost per mile.

Minimum state share
percentage of 41.66% percent
for FY25. Districts paid greater of
local share percentage or state
share percentage. ORC
3317.0212



FINANCIAL DATA REPORTING
1

T-1 = ACTUAL Riders
Preschool,

Community School (1.5),
and Non-Public (2.0)

riders/miles Reported by
District




IMPACT OF THE T-REPORTS

Funding Ramifications

Future Data Collection

Student Counts



YOUR KEY CONCERNS

Tracking Expenses

EMIS vs. T-1 Data

How to Collect Data

Accurately Recording Data



SEQUENCE OF EVENTS

Bus Inventory

Driver Count Sheets

Driver Counts 1st FULL week in October
(October 7-11)



SEQUENCE OF EVENTS

Compile AVERAGE DAILY Driver Counts
and DAILY Miles

Data Entry

Data Validation



SEQUENCE OF EVENTS

Internal Audit

Signature “Gathering”

Submission



LET’S BEGIN

Are your buses listed in the Bus
Inventory?

Create Driver Count Form

Driver counts taken first full week In
October



Get Started: Log into SAFE
https://safe.ode.state.oh.us/portal

@OHID

Ohio's Digital Identity.
One State. One Account.

( Create account )

Loglin

ssssssss


https://safe.ode.state.oh.us/portal

Get Started: Log in to SAFE
safe.ode.state.oh.us/portal

My Apps

Click the star to pin your favorite apps to the top of the page.

A 1A

CCIp Drivers License Lookup Human Resources
System Management System
Grant application & planning Look up drivers license information Timecard entry and leave requests
system
Details Open App Details Open App Details Open App

e

Ohio Education Dijectory
System (OEDE)

Directory of schools and districts

Gombined Charitable
Campaign

School Transportation

Combined Charitable
Contributions

Submit data and view reports.

Details (¢) Open App Details Open App

1eT

Monitoring

Tracks grant monitoring, program
analysis, data

Details Open App

Compliance

Tracks grant monitoring, program
analysis, data

Details Open App

®hio

myOhio

State of Ohio employee intranet
with benefit, pay and
ePerformance information.

Details Open App

ﬂ )

Department of Education
Profile Setup

Create a profile with the
Department

Details Open App


https://safe.ode.state.oh.us/portal/

Get Started: Log in to SAFE
safe.ode.state.oh.us/portal

C (O & sfps.odestate.oh.us/SFPS/SFPSLanding/

22 Apps G Google @ Home O School Transportati... O Dashboard Lawriter - ORC Lawriter - OAC [} Pages - Home

mmﬂml of

Education

Change TextSize: A A A

Search

advanced search

Home

Printer Friendly Version

sﬂ_ SSFtEAccount | Welcome to the School Foundation Payment System
ign Ou

Jason Heilman

Click here to access the Transportation Modules



https://safe.ode.state.oh.us/portal/

> Add

= Maintain

> BMV Info

> Suspend

> Search Batch

= PS View

> Driver Search

> Search Reports

___= Drivor Scarch__|
I
e
__> Soarch Roports_ |
_zadmin |
IS
_>Toadmin |
_>Meainterance |

= Access Window

> Due Dates

Transportation Module
SELECT REPORT YEAR 2025

Printer Friendly Version

T1 Reports
Current Report (Listed by Fiscal Year)
2025

***T-1 Data Reporting Reminders™*™*

= Report community and nonpublic school ridership data
- Ensure that you have updated your bus inventory data with
o Current odometer reading and date of reading.
o Condition of bus (Good, Fair, Poor) at current FY reporting time.
» Report is due no later than November 1st.
= The greater of the morning or afternoon average ridership may be used.
= All Pre-School students that you provide transportation services are calculated in payment.
= Districts will receive funding for all students transported, not just the students that reside more
than 1 mile from the school they attend. For reporting purposes, we will still ask for the students
less than 1 mile be reported.

> Org Lists

Report Status

Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status
Approved Status

Saved Status



TRANSPORTATION MODULE

Home
Printer Friendly Version

Bus Inventory Search

> Add
= Maintain
= BMV Info

Add.

District

= P3 View
= Driver Search

[ ]

[<Click Here to Select> V| l:l

Chassis Serial Number (VIN) Body Make

» Search Reports

Use the following criteria to search for a bus. One or multiple fields can be used in the search criteria. Click Search.

To edit a bus currently in inventory, click an icon in the Edit column next to the bus to be viewed or edited. To remove a
> Suspend bus from inventory, click the icon in the Disposal column next to the bus fo be disposed of; or if only one bus is found,

s Search Batch click the Disposal icon on the next page. To add a bus to inventory, enter only Chassis Serial Number (VIN) and click

Local Bus Number Registration Number Body Type

Chassis Make Chassis Model Year  Assistance Fund

| | |<Click Here to Select> v|

= Access Window
> Due Dates
= 0rg Lists

|<Click Here to Select> V|

|-=:C|ick Here to Select> v|

Ulnclude Qut of Service
buses

Ulnclude Transferred
huses

Uinclude Sold buses




STATUS OF BUS INVENTORY

*Assigned

°Spare

* Qut of Service



TRANSPORTATION MODULE

We are requiring the update of the “assigned” buses information to be updated.

> Add

> Maintain

= BMV Info

> Suspend

> Search Batch

> PS View |

= Driver Search

> Search Reports

> Access Window

> Due Dates

= Org Lists

SAFE Account
ign Out

Jason Heilman

About ODE
State Board of Education
Legislative Services

LAl riditdid

Use the following criteria to search for a bus. One or multiple fields can be used in the search criteria. Click Search. To edit a bus currently in inventory, click
an icon in the Edit column next to the bus to be viewed or edited. To remove a bus from inventory, click the icon in the Disposal column next to the bus to be

disposed of; or if only one bus is found, click the Disposal icon on the next page. To add a bus to inventory, enter only Chassis Serial Number (VIN) and click
Add.

District
, , , ) ~|
Local Bus Number Registration Number Body Type
[ <Click Here to Select> |
Chassis Make Chassis Model Year Assistance Fund
[ <Click Here to Select> v | [ ] [ =<Click Here to Select> ~ |
Chassis Serial Number (VIN) Body Make Include Out of Service buses

[<Click Here to Select> ~ | () Include Transferred buses

[Jinclude sold buses
Add

| Body Chassis
Edit | Disposal Local |Registration Type Make Make <Model Service Usage Assistance Sold
Number| Number Year = Type Fund
. Transit - .
@ | = 1 Q04622 | Engine |Bluebird |Bluebird | 2017 | Soard | ASSIaned | ocayy funded venhicle
front
_ Transit - |
2 | =5 2 Q01886 Engine |Bluebird |Bluebird | 2016 | Board- | Assianed | .., funded vehicle
front owned bus
— Transit - Board- Spare
(% ¢ s 3 18072 Efnrgrl::e Bluebird | Bluebird | 2005 owned bus Locally funded vehicle
o Transit -
@ | = 4 Q09651 | Engine |Bluebird |Bluebird | 2021 | Soard | AsSIaned | | ocayy funded venhicle
front
Transit - Funded bus over 10
—_ ; . . Board- Spare years old which
[P % 5 12814 Efr:grljr;e Bluebird | Bluebird | 2000 | J©2 -0 bus convarted to ocal per
PEROAC3301-85-01
| 12345




TRANSPORTATION MODULE

We are requiring the update of the “assigned” buses information to be updated.

= Suspend

= Search Batch

Chassis Serial

1HWVBBCFPALHG9G368
MNMumber (WD |

[456 | Transaction Type
= PS Wiew Local Bus Number = New O Used Sale Date
= Driver Search Registration
Nu?n ber 57912 |
Purchase Date Month Day Year ﬁﬁmg(;?te of Title  Scs198z86 |

~ Search Reports Usage Body Make [Bluebird ~|
Odometer Reading Body Year
Odometer Reading Month Day “Year
Date [Jun ~[15  Jzo0z | Body Type = il
- Rated Body
Condition [Good | Capacity
> Access Window Chassis Make [International ~ | Engine Size |3E‘~[] |
= Dus Dates Chassis Model [International | Transmission @ Auto O Manual
> Org Lists Chassis Year GVWR (Ibs)
Seatbelts Y eas @ MNo Fuel Type [Diesel |
Wheelchair Lift OYes ®MNo
& SAFE Ac t Wheelchair ) _
Sign Ot sene Capacity D Assistance Fund | =Click Hare to Selact> L
Onvwnership [Board-owned ~ Assistance Fund

Fiscal Year

Undo Bus Sale
Delete this Bus

*3 H




TRANSPORTATION MODULE

We are requiring the update of the “assigned” buses information to be updated.

= Suspend

= Search Batch

= PSS YWiew

= Diriver Search

= Search Reports

= Access Window

= Due Dates

= Crg Lists

& SAFE Account
Sign Ot

Chassis Senail

1HWBBCFPALHE96365
NMumber (WIND |

(456 | Transaction Type
Local Bus Number ® New O Used Sale Date
Registration
Nu!:r_;n ber |5?91 2 |

Month Day “Year Certificate of Title
Purchase Date [Jun ~ | L _l Number

Body Make
Body Year

Body Type
Rated Body
Capacity
Engine Size

| Transmission
GVWR (Ibs)
Fuel Type

[Good ~ |

Condition

Chassis Make
Chassis Model
Chassis Year
Seatbelts
Wheelchair Lift

Wheelchair
Capacity

[International ~ |

| International

O es @ NMNo
COwes @ MNo

CH

[Board-owned et

Assistance Fund
Assistance Fund
Fiscal Year

Undo Bus Sale
Delete this Bus

Cwwnership

[254195286 |

[ Bluebird |

= ~|

55

[3s0 |
@ A uto O Manual
25000

EI
7
o

~]

| = Click Here to Select=

"l H



TRANSPORTATION MODULE

We are requiring the update of the “assigned” buses information to be updated.

= Suspend
= Search Batch

= PSS Wiew
= Diniver Search

= Search Reports

= Access Windome
= Due Dates
= Org Lists

& SAFE Account
Sign Owrit

Chassis Serial
MNumber (WD

Local Bus Mumber

Registration
MNumber

Purchase Date

Usage
Crdometer Reading
Cdometer Reading
Date

Conditio

Chassis Make
Chassis Model
Chassis Year
Seatbelts
Wheelchair Litt
Wheelchair
Capacity

Crwwnership

| THYBBCFP4LHG9G365

456 |
) Mew O Used

[57912 |

Month Day ear
|Jun "v"|1 I
[ASSIGNED

E |

Month Dray ear

| Internaticonal |

Y eas Mo
OO weas @ Mo

o ]

[Board-owned it

Transaction Type
Sale Date

Certificate of Title
MNumber

Body Make
Body Year
Body Type
ated Body
apacity
Engine Size
Transmission
SGWWR (Ibs)
Fuel Type

Assistance Fund
Assistance Fund
Fiscal Year

LUndo Bus Sale
Delete this Bus

[254195286 |

[ Bluebird

1990

[c

[360 |
) Asuto O Manual

25000

[ Diesel

~|

| =Click Hare to Selact=

"l H



STEP-BY-STEP

Record daily mileage and student counts and
compute AVERAGE miles and students for
five-day week.

Retain Driver’s original copies of daily
count sheets for five years!




Student Count form

X

X

X




Bus # Driver
MNMonday MNMonday
A PN
Name Elementary
Shuttle

Middle School

High School

JWVS

Non Public

Community

Special Education

Miles AN Start at bus garage
AN End at bus garage
Field trip miiles Start
End
Miles P Start at bus garage

P End at bus garage

Count students as they exit the bus in the moming
Count students as they enter the bus Iin the afternocon



COMPLETE THE TRANSPORTATION PROGRAM SURVEY

Transportation Contact Information

Email Address

Phone Number



COMPLETE THE TRANSPORTATION PROGRAM SURVEY

s o - e

Transportation Program Survey

| Saved Status

Instructions

= Add

= Maintain Transportation Contact Title Email Address Phone Number

= BMW Info

> Suspend

> Search Batch Please note that if any of the above transportation staff information is incorrect, please log into OEDS and make
the appropriate corrections

Route Service Provided
Please identify the level of transportation service that is most common for each of the following grades. ITf no
service is provided for an individual grade, check "No Service":

> PS View

> Driver Search |
_ Grades Program Type Walk Limit to School
No Public Yellow Other
=Busivenory | Serviee  Transi
I P - -~ - - Mone Ride .~
> Search Reports | K ] () (] [ .5 ~ l
Cmhamn ] e o O O (5 ~
A ° o - - o (None Ride |
ronamn | " - = - - (None Rids ]
= Meinienance | i - = = - None Ride_~|
12 (] O (. (] [ None Ride ~|

> Access Window

e 1.Do you provide transportation to STEM, community and nonpublic school students?

L O ves O No

2.1f Yes, Are the students routed with the public-school students or do they have their own designated routes?

O shared routing

O Own designated routing
r~~] & SAFE Account © Both
‘B ¥ sSign Out

R




COMPLETE THE LOWER PORTION
OF THE PROGRAM SURVEY

Program Type
Walk limit to school (By grade)
Enter new data request for Community/Nonpublic/STEM

Click “NEXT” button



TRANSPORTATION MODULE

Transportation Program Survey
Saved Status

I ISl it Liv? 1>

= Add

=> Maintain Transportation Contact Title Email Address Phone Number
|

> BMW Info

> Suspend

-~ Search Batch Please note that if any of the above transportation staff information is incorrect _please log into OEDS and make

Route Service Provided

= PS View I service is provided for an individual grade, check "No Service™: - ITne
= Driver Search I
_ Grades P_rogram Type Walk Limit to School
_ Ser;l:':;ce "Il?rl:-::;?t YSILC;W Other
IS I e . = = = [None Ride ]
> Search Reports I K J (] [ .5 ~ ]
1-8 O O [.5 ~ |
L o — - — - Neemae——)
IEEE T | 10 - - — . (None Ride——
e | 11 O - - - MNone Ride <]
_=Maintenance | 12 O O O = [None Ride ]
> Access Window
> Due Dates Do you provide transportation to STEM, community and nonpublic school students?
= Org Lists O ves @ No

2.If Yes, Are the students routed with the public-school students or do they have their own designated routes?

O shared routing
O own designated routing

T1 Completion Page

& SAFE Account
Sign Out

o



MILES BY BUS

List buses by local bus number, status, usage.

Enter miles by bus for public, nonpublic,
community school and special education.



STEP-BY-STEP

* Add daily miles
then divide total
miles by 5.

* Enter average
daily miles to be
reported by bus.



BASIC: MILES BY BUS

Maintain

B Info

Search Batch

PS Wiew |

Driver Search

Home

Miles

Instructions

Sort by Local Bus Mumber

Local
Bus No.

LE R DR ER kN e

12345

Bus
Registration
MNumber
83315
20228
23316
999999
83317
283318
5543
23319
14212
10569
10570
19155
83320
83321
19135
20229
10571
572910 ...

Service
Twvpe

Usage Type

SPARE
ASSIGNED
SPARE
SPARE
SPARE
ASSIGNED
ASSIGNED
ASSIGNED
ASSIGNED
ASSIGNED
SPARE
ASSIGNED
SPARE
SFPFARE
ASSIGNED
ASSIGNED
SPARE

Public
School

0
Ta
0
o
0
u
a8
0
Ta
105

oNDODODOo

Sort bw Registration Mumber

[ s o o o o o

Conmimunity

-
s s o R o o o R o o o R o o I o Y o

SubTotal

Bus Inventory Maintenance

endhy Wersion

Sawved Status

special |Total
Educaticon

0 o Edit

o T2 |Edit

0 o Edit

o o Edit

0 o Edit

o] 60 |Edit

o] oz |Edit

o oz |Edit

a] T8 |Edit

0 106 |Edit

0 o Edit
13 136 |Edit

o o Edit

0 o Edit

a] 106 |Edit

o] 122 |Edit

o o |Edit



EDIT MODE: MILES BY BUS

= Maintain

= B Info

= Search Batch

= PS View

= Driver Search

= Search Repors

= Access Window

= Due Dates

= rg Lists

Miles by Bus

Instructions

Sort by Local Bus Number Sort by Registration Mumber

Local
Bus
Mo,

SRR RER®EENEmLWwN R

Bus

Registration
Number

83315

20228
83316
999999
83317
23318
G543
23319
14212
10569
10570
189155
83320
83321
19135
20229
105871

Service
Type

12345678910

Usage Type Public MNon Cormmunity
School Public School
School
[SPARE ~||[o (D [0 |
ASSIGHNED T8 0 (1]
SPARE 1] 0 (0]
SPARE o 0 0
SPARE 1] 0 (1]
ASSIGHNED o 0 o
ASSIGNED og 0 0
ASSIGNED o oz 1}
ASSIGHNED B 0 L1]
ASSIGNED 106 o 0
SRPARE 1] 0 0
ASSIGNED o 0 i
SFPARE o 0 0
SPARE (1] 0 0
ASSIGNED o 0 106
ASSIGHNED 128 0 [0]
SPARE o o 0

SubTotal

106
128

Praw

Status

Special
Education

ﬂ

EE

m
-

oo o0PowOoooDooaolooao

Total

78

ocoo

=1
98
o2
T8
106

136

106
128

BEEEEE
== =35 =

ZEEEEEE
==Y =3 EY 2

m
E



Miles by Bus

Approved Status
Instructions
Prev Next
Sort by Local Bus Number Sort by Reqistration Number
Local Bus Service|Usage Type| Public| Non |Community||| SubTotal Special |Total
Bus No.|Registration| Type School| Public| School Education
Number School
1 20215 I ASSIGNED | 46 0 0 46 0 46
2 8652 I ASSIGNED | 48 0 0 48 0 48
3 147 I ASSIGNED| 96 0 0 96 0 96
5 22539 I ASSIGNED| 60 0 0 60 0 60
8 3755 I ASSIGNED | 48 0 0 48 0 45
1
Prev Next




MILES BY SERVICE TYPE

* ASN = Assigned

* SPR = Spare

* Public, Nonpublic, Community,
Special ED

e Services Types Summary



TRANSPORTATION MODULE

Printer Friendly Version

Miles by Service Type

Instructions
> Add
Prev Next
> Maintain
> BMV Info Service Usage  Description Public Non Community Subtotal Special Total
- B Type School Public School Education Daily
> Suspen ASN SPR School Miles
> Search Batch
| 70 29 Board-owned 2433 899 309 3641 514 4155
I 31 g Contractor- 176 491 991 1658 0 1658
owned
> PS View | Subtotal 101 38 2609 1390 1300 5299 514 5813
> Driver Search
—I v 0 Board owned, 0 0 0 0 0 0
Privately
_ VI 104 owned, other 937 0 0 937 5756 6693
vehicles
_ Subtotal 104 937 0 0 937 5756 6693
> Search Reports |
Total All
_ Service 205 38 3546 1390 1300 6236 6270 12506




PUPILS BY BUS

Lists buses by local bus number, service type

Student Counts- greater of the am or pm ridership average

(even though new language allows for all riders to receive
payment we are requesting the data be separated within a
mile and more than a mile). This can be determined per bus.

By Category of Public, Non-Public, Community, Special
Education



STEP-BY-STEP

* Add daily student counts then divide
counts by b.

* Record this AVERAGE daily riders to
be reported by bus and by category.



PUPILS BY BUS

Pupils bwv Bus

= Add

e

= B Info

Sort Local Bus Mumber Sort by Bus Registration NMumber

Local Bus Service Distance Public Mon COoOmmimLn ity Special Type | & 11
Bus No. Registration Tvpe Tyvpe School Public School Education Pupils
Number School

2 Within 1 Mile o o o o

0228 1 ;Mlln:e :I:r Maore A0 1] u ] 40 Edit
Wiew pecia

=Ps Eduwcation 1 1

= Diriver Search & Within 1 Mile o o o o
83318 1 1 l'u'lil-_e or More o & T 13 Edit
Special o o -

Education
T Within 1 pile o o o o
1 Mile or Mare 51 o o 51

.iij
g

Special
Education 4 4
a8 Within 1 Mile o o o o
aB3318 1 1 Mile or Maore 22 1] 33 (-n] Edit
Special o o
Education
k- ] Wilithin 1 Mile o o o o
14212 1 ;Mllt.t -:I:-r Mare 26 o o 26
pecia
Education 2 2
10 Wiithin 1 Mile 1] 1] n} 1]
10569 1 1 Mile ar Mare 30 o o 30
Special o o
Education
12 WWithin 1 Mile o o o o
19155 ' 1 Mlll-_'.' ar Maore o o 8 &
Special 3 3
Education
15 Wlithin 1 Mile 1] 1] o o
19135 1 1 M"l-.': or Mare o 3G 3 39
Special o o

Education




EDIT SCREEN: PUPILS BY BUS

Pupils by Bus

Instructions

Sor by Local Bus Number Sorl by Bus Registration Mumber
= Suspend

= Saarch Bateh Local Bus Service Distance Public Mo COmimiLn ity Special Type | & 11
Bus No. Registration Type Type School Public School Education Pupils
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Pupils by Bus

Instructions
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PUPILS BY SERVICE TYPE

* Summary Page of Service Type

e Student Counts

* Edit page for types 1A, 3 (ll1), 4 (IV), 5 (V), 6 (VI) and
Community Schools type 7 (VII)



SERVICE TYPE 1A, 3,4,5,6 AND 7
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LTI 1 TSy W el S
Pupils by Service Type
Instructions
Nt
Service Description Distance Public Non Community Subtotal Special Total
Type Type School Public School Education Pupils
School
Within 1 25 0 0 25 0 25
Mile
District 1 Mile or 273 0 0 273 0 273
Bus More
Special
Education 0 0 0 0 0 0
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SPECIAL EDUCATION PUPILS BY BUS

* Special needs students can be serviced by a regular
education route.

* If total of special needs students is less than 50
percent, all are counted as regular education riders.



REVIEW: HOW TO ACCOUNT FOR SPECIAL
EDUCATION PUPILS

* Only count “special needs” students if 50 percent or
more riders are eligible.

* Special needs are identified AND an IEP noting
transportation as a related service is in effect.

* A student may still be a special needs student, but for
funding purposes, they must meet the above criteria.



PRO-RATED
SPECIAL EDUCATION PUPILS

If 50 percent or more riders are eligible special needs
AND total student count is NOT 100 percent special
needs, count is to be pro-rated.

20 students counted, 11 are special needs, then counts
would be 9 regular education and 11 special needs.



TYPE IV WAIVERS

A: Previously Approved

B: New Type IV

C: College Credit Plus and Postsecondary Pupils

D: Open Enrollment below Federal Poverty Line



PAYMENT IN LIEU OF

* Entries should not indicate name of student and
related payment.

* Indicate total number only.



TYPE IV WAIVERS
PAYMENT IN LIEU OF

Passed Board Resolution for STUDENTS.

Students are ELIGIBLE but IMPRACTICAL

Not an option If other types of service are available.

Must be supported by proper documentation.



TYPE IV WAIVERS
PAYMENT IN LIEU OF

* Last resort.
* All other types are exhausted/not available.

* Minimum payment in lieu of is calculated as 50% of the
statewide average per pupil to provide transportation from
pervious year. Previous year average cost is $1,167.72 per
student 50%=%$583.86 for FY25.



PAYMENT IN LIEU OF

Home

Instructions

= haimitain

= BhW Infos

Prnnter Friendihw Wersioan
Twpe 'Y Waivers

= Search Batch

= PSS Wiews

= Driwver Search

Pulbrlic pupil cowrnd

Waiver Twywpope Dves.cripiiom Pupils
=N Fraviously approwved, =till eligible for payrmeaent this fiscal vear L8]
=3 Mew Type I pupils — waiver forms and board resolution reguired 1122
L Fost-secondary puppils prowviding owen transport - mo waiver reguired L8]
D Opeaen enrclirmaent pupils below Fedaeral powverty line - no wailver reguired L8]
Total Service Ty pe 'V Pupils on this Page: 1122
Total Service Type 'V Pupils im Prewvious Sectiom: 1122

Totals of A, B, &, and D puils muust equal thhe comiizined total of Type I Public, Community School, and RMon-—




AUDIT REPORT

AL T

Home
T1 Completion
Instructions
Ak Transportation Sarvice Lewvel (T1) Cartification
rAaintain This form is electronically signed when you click 'Sign Report,” By signing, yvou are confirming that the information provided by you is

accurate and all pupil transportation is in compliance with existing lavws and Ohio Pupil Transportation Operation and Safety Rules (OAC

B Info 2301-83-03 through 3301-83-22).

Suspend

District staff are recommended to review the audit report prior to submitting this report.

PSS WView

Diriver Search | Sign Flﬂp-ur‘l

Report Comments (* Hold comments are shown in bold)

Mew Comment:

[ I send comment to Transportation Stafr




T1 AUDIT REPORT

* Lists Miles and Pupils by service type(s) for current year and
last year.

* Provides Variance Percentage.

* Must be viewed by treasurer and superintendent to
populate sign and submit button.

W



T1 AUDIT REPORT

Value Value Variance
Miles by Service Type | (Board-owned) - Public School 44445 26725 66.30 %
Miles by Service Type | (Board-owned) - Non Public School 2925 486 49939 %
Miles by Service Type | (Board-owned) - Community School 10958 915 1,097.60 %
Miles by Service Type |l (Contractor-owned) - Public School 0 85995  -100.00 %
Miles by Service Type |l (Contractor-owned) - Non Public School 0 5776 -100.00 %
Miles by Service Type |l (Contractor-owned) - Community School 0 14636  -100.00 %
Miles by Service Type |l (Contractor-owned) - Special Education 0 1160 -100.00 %
Miles by Service Type VI (Privately owned, other vehicles) - Special Education 466 320 4563 %
Pupils by Service Type | (Board-owned) - Public School - 1 Mile or More 20004 13575 47 .36 %
Pupils by Service Type | (Board-owned) - Non Public School - 1 Mile or More 1264 78 152051 %
Pupils by Service Type | (Board-owned) - Community School - 1 Mile or More 4823 264 1,726.89 %
Pupils by Service Type Il (Contractor-owned) - Public School - 1 Mile or More 0 3696 -100.00 %
Pupils by Service Type Il (Contractor-owned) - Non Public School - 1 Mile or More 0 1731 -100.00 %
Pupils by Service Type Il (Contractor-owned) - Community School - 1 Mile or More 0 5653  -100.00 %
Pupils by Service Type Il (Contractor-owned) - Special Education 0 149 -100.00 %
Pupils by Service Type lll (Public transit) - Community School - 1 Mile or More 951 434 11912 %
Pupils by Service Type VI (Privately owned, other vehicles) - Special Education 16 10 60.00 %

W



T1 COMPLETION PAGE

*Also known as Signature Page

*Click “SIGN REPORT”

*Click “SUBMIT REPORT”



COMPLETION PAGE

Home

Printer Friendlhy Wersion

T1 Completion

Instructions

Transportation Service Lewvel (T1) Certilcation

This form is electronically signed when you click 'Sign Report.” By signing, wvou are confirming that the information provided by you is
accurate and all pupil transportation is in compliance with existing laws and Ohio Pupil Transportation Operation and Safety Rules (OAC
2301-82-03 through 3301-83-22).

District staff are recommeandaed to review the audit report prior to submitting this report.

T1 Transportation Service

= PS Wiew |

= Driver Search

= Search Reports
Report Comments (* Hold comments are showvwn in bold)

Mew Comment:

[l send Comment to Transportation Staff



T1 COMPLETION PAGE

* Verify signature.

* If other signatures are incomplete REPORT
STATUS will indicate such.

* SIGN and “SUBMIT?”



T1 Completion

Aapproved Status

Instructions

5

Transportation Serwvice Lewel (T1) Certification

aimntain This form is electronically signed when vou click "Sign Report.” By signing. yvou are confirming that the
iNmnformation provided by yvou is accurate and all pupil tranmnsportation is in compliance with existing lawvws and

W ITnTfo Ohio Pupil Transportation Operation and Safety Rules (OAC 3301-83-03 through 3301-83-22).

Jspend District staff are recommended to rewview the audit report prior to submitting this report.

zarch Batch
Aaudit Report T1 Transportation Service

Report Signmnatures
e Na_m_e Iitle Signed Date

—— e Ee e e m Ml a . e ey

ul

tiver Search |

Report Status
Aapprowed

zarch Reports

Report A pproved

I

scess WWVIindoww

ae Dates

g Lists

TE Aaccount

b

son Heilrmanm

S ) send Comment to Transportation Staff

oard of Education Audit Report
tive Services

T1 Transportation Service




SIGN AND SUBMIT

Sign report
v Treasurer

v'Superintendent

v’ Must view audit report

SUBMIT REPORT

o



ADDITIONAL T-REPORTS

Data Needed Filing Due Date

T-8

DOT Physical

W

Driver Physicals

Vendors may need both
DOT and T-8.

Dated after May 1, but before
the first day of school for
returning drivers

New hires between Jan. 1 and
April 30 (good until following
year May 1)

DOT Physical NOT acceptable.



ADDITIONAL T-REPORTS

T-9 Driver Training Record Within 30 days of last
date of training as noted
by On-bus-instructor

T-10 Accident Report for any  Within 15 days of
accident where damages accident
are greater than $1,000
total Must Notify OSHP within
48 hours regardless of
amount



T-REPORTS SUMMARY

Data Needed Filing Due Date

T-1 Miles and Student counts Nov. 1

T-2 Directly Related Aug. 31
Transportation Expenses



FILING DEADLINES

°T-1: November 1

Calendar

Amended T-1:
Jan. 31

*T-2: Aug. 31

o



REMEMBER: BOOK ENDS

T-1

Funding by
students or
miles.

Can’t have one without the other!



CONTACT THE DEPARTMENT
WWW.SCHOOLBUS@EDUCATION.OHIO.GOV

614-466-4230



http://www.schoolbus@education.ohio.gov

QUESTIONS?

EDUCATION.OHIO.GOV

"1 Department of
?%W Education &
s

Workforce
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